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Introduction
This Decision Explorer Newsletter Compendium is a collection of articles from Decision Explorer
Newsletters. This compendium does not include any of the case studies that have been published in
Decision Explorer Newsletters.
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Smart Linking
In Decision Explorer® training we often say that learning how to use the command line and taking
advantage of it will enhance your use of Decision Explorer®. One facility, which is often overlooked,
is the ability to create chains of links in one action.
The simple command “1 + 2” creates a single (positive) link between concept 1 and concept 2. This
is very useful when using Decision Explorer® in meetings because when someone says: “I think that
there should be a link between concepts 207 and 513”, you don’t have to find or display concepts
207 and 513. A simple command puts in the link for you and the technology doesn’t get in the way
of the progress of the meeting.
Sometimes it is necessary or desirable to create more than one link at a time - a chain of linked
concepts.
The command “1 + 2 + 3 + 4” creates three links, in a chain, from concept 1 to concept 2, 2 to 3,
and 3 to 4. This is useful for connecting a line of argument that is obvious on the screen - particularly
after doing a brainstorm where the facilitator just used the rapid entry mode and typed ideas as they
were suggested.
A more advanced linking option allows you to enter multiple links to a single concept - not in a
chain. To do this, add a “greater than” to the link command thus: “1 > + 2 + 3 + 4”. This again
creates three links, but not in a chain this time. Here, all the links are connected to concept 1
because the > link modifier has been used. Concept 1 is linked “outward” to concept 2, concept 3,
and concept 4.
If you want to link the concepts “inward”, use the “less than” character (you can imagine that the link
direction is the same as the way that the > or < modifier is ‘pointing’). Thus “1 < + 2 + 3 + 4” creates
three direct links. Here, all the links are again connected to concept 1 but this time in the opposite
direction because the < modifier was used. The links created are from concept 2 to concept 1, from
concept 3 to 1, and from 4 to 1.
Mixed link types
In the command “1 > + 2 - 3 t 4” there are multiple link types being defined, mixed into the same
command action. This command creates a positive causal link from concept 1 to concept 2, a
negative causal from 1 to 3, and a temporal link from 1 to 4.
Using the command line does speed things up and it is very flexible. Perhaps you will find yourself
making more use of it in future for entering links.
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Cluster Analysis - How It Works
The cluster command in Decision Explorer® gives you a form of analysis based on the structure of
your model. It takes no account of the contents of the concepts’ text or their meaning: the analysis
is based solely on the structure of the links between concepts. All links are considered as having an
equal weight (that is there is no sense of any particular type of link being “stronger” than another).
The clusters that are identified are mutually exclusive i.e. concepts can appear in only one cluster at
a time.
A typical use of cluster analysis is to split a large model up into related sections. With no
“seeds” (explained later) the effect of the analysis is to produce a numbers of sets, which are
relatively isolated clusters of ideas. You may then want to explore the “bridges” between and
“islands” of clusters. Going through a cycle of model elaboration and clustering can be very helpful
when constructing a model. By mapping the clusters you can quickly get insight into “missing links”,
for example, when you have two clusters which are talking about the same kind of issues. The idea
behind the cluster analysis is that the meaning of a concept is related to the concepts that it is
linked to, so the groups of concepts that are identified will relate to roughly the same area of the
discussion.
In this example, concepts [50] and [54] have similar explanations and consequences (i.e. they are
linked to the same concepts). Therefore they are likely to form part of a single topic. Intuitively even
a large model can be broken up into a series of topics in this way, although for complex models the
identification of the centres and boundaries of each topic is necessarily an art rather than a science.

In Decision Explorer® the cluster analysis should provide you with a “suggestion” of independent
topic areas. The word “suggestion” is used for two reasons. Firstly, because you are likely to map
the clusters, then edit and change links, add explanatory and consequential concepts. And
secondly, because cognitive maps are rarely “comprehensive” and “normalised”: for example, in a
single map some concepts will cover small details, while others cover complete policy areas. The
underlying mathematical methods used in cluster analysis rely on the “comprehensiveness” and
“normality” of the initial data and cognitive maps rarely satisfy these criteria.
In Decision Explorer® “Jaccard Coefficients” are used to identify clusters. For cluster analysis we
require a “matching” score for each concept in relation to the others in the surrounding map. For the
small map shown here, with only 5 concepts, the table of “matches” would look like this:
50
51
52
53
54
50
0
1
1
0
0
54
0
1
1
1
0
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For concepts [50] and [54] the Jaccard Coefficient is simply:
Number of concepts directly linked to pair = 2 = 0.67
Total number of concepts linked to pair
3
This ignores concepts that are not linked to either concept [50] or [54] (the number of indirect links
is usually large in relation to the number of direct links). We can generate a matching score for any
pair of concepts in the model. The clusters are built up using a simple, single link hierarchical
clustering method. We begin by picking up a concept, we then pick up another concept and
compute the matching score between the two concepts. If the matching score is greater than a preset threshold value the concepts are placed in the same cluster (set), otherwise the second concept
forms the seed for a new set. Another new concept is then picked up and a matching score
computed for this concept and the seed concept of each existing cluster set. The process continues
until all of the concepts in the model have been analysed and their matching scores calculated. If a
seed set is specified at the start of the cluster analysis, the concepts in the seed set are used as
the initial cluster sets, thus providing “prompts” for the analysis process.

For cognitive maps this clustering process usually produces a lot of small clusters. The cluster
command also amalgamates small sets into larger ones by merging groups towards “head”
concepts until the target set size is reached. The sets are then inspected again and floating heads
and tails are merged into the nearest group. The target size obviously has a large influence on the
final number of clusters. The default target size setting is 30 concepts per cluster, but this can be
changed by the user in the range 5 to 90.
Certain assumptions have obviously been made in the clustering algorithm which has been
developed for Decision Explorer®, for example, the inclusion of floating head and tails is one which
resulted from experience in using the tool. Experience has shown that in “real life use”, more
sophisticated methods of clustering are inappropriate when dealing with cognitive maps.
Generally speaking, the clustering method is useful in large models which cannot be split visually
into areas of related issues, and it will reveal clear cut groups (clusters) of concepts, if such groups
exist. Where concepts in a map are very heavily interconnected the value of clustering is much more
questionable. You can “force” clusters by reducing the target size to a minimum value of 5 concepts
per cluster. However, if the “forcing” process still reveals relatively large clusters, then this is an
indication that the model is heavily interlinked and cannot be broken down further.
It is important to remember that cluster analysis gives you a hypothesis about the model structure
and should be treated as such, but it can be very useful in directing you to “natural” topics within the
data, if they exist.
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Mapping Options Explained
The map options dialog controls what is displayed and how it is displayed when you ask Decision
Explorer® to produce a map. This dialog influences the MAP command (used from the command
line), the MAP CONCEPT item in the analysis menu and the ALT+M key combination.
If more than one concept is selected when you issue the map command, Decision Explorer® will use
only those concepts that are selected in the map. For example, if you select several concepts and
use the command MAP SC (which stands for "map selected concepts"), then Decision Explorer®
will produce a map based only on the selected concepts. Similarly if you used the command MAP
22#25#26, Decision Explorer® will produce a map which displays only concepts 22, 25 and 26.
However, if you only have only one concept selected (for example, the concept represented by the
red box in the diagrams above), Decision Explorer® will map the selected concept as determined by
the options which have been set in the map options dialog.

The same number of concepts are shown in each of the diagrams above. The diagram on the left
shows concepts which have been mapped using the banded option, to three levels. The dotted lines
shown the boundaries between the levels. The diagram on the right shows concepts which have
been mapped using the fanned option, to four levels. The colours of the concepts at each level have
been changed to show more clearly the division between levels. These options give you flexibility in
the way that your maps are displayed and the number of concepts that are included in your maps.
The banded option works are follows, Decision Explorer® tracks up (and down) from the selected
concept until it reaches a branch point. At each branch point one level (band) ends and another
begins. So, working out from the selected (red) concept, the first level includes all of the dark blue
concepts, the second includes all of the pale blue concepts and so on. A new level (band) starts on
each line of argument when a branch point is reached.
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The fanned option is a simple, step-wise division from one concept to the next, so the divisions
between the levels occur between each subsequent concept along the lines of argument.
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Password Protecting Models
Those of you who share models, exchange models with clients or who use models for teaching may
well find password protecting models a useful feature. This feature has been in Decision Explorer®
for many years but, until now, has never been publicised.
Decision Explorer® allows you to control the level of access which users have to a model, ranging
from full access (no password settings) to read only access. To make full use of the password
protection system you must ensure that all of the users who you are exchanging models with are
using Decision Explorer® version 3.1.2 (This means that you should have service pack 3 installed.
Please visit www.banxia.com and follow the Decision Explorer® software update links if you need
this service pack).
You can pre-set the password status of a model and later give additional access rights to users by
using a password system. It is not possible to set up individual user passwords for every member of
a large research or management team (and this is not generally how you would try to use the
system) but it is possible to set up a default level of access and two passwords per model, to give
two groups different levels of access. For example, you might want to give read only access to the
sales team, while giving more or full access to the strategy team. Or you might want to give read
only access to a review panel, while giving the ability to add and edit new information to the research
team (saving full access – allowing adding, editing and deleting new and existing information – for full
team meetings, when supervisor access would be used). You may also be working with a client who
does not really know how to use the software. Password protection models would remove any
worries about information being lost or accidentally changed.
Once password protection has been enabled (by typing the command superpass <password>) the
default level of model access (when you close, save and open the model again) is set to “None”. This
means that the display screen will appear blank i.e. no information is displayed. You may want to
change this default, so that the default level of access is “ReadOnly”. This would mean that users do
not have to login to view the model. To change the default level of access you use the command
stdlevel <level>, where <level> is one of the options listed below. You must be logged in as
supervisor to be able to change the standard level of access.
Once you have enabled password protection, you can then set one or both of the passwords to give
the desired level of access to other users. For example, “newpass mypassword delprev” sets up
the “DelPrev” level of access for the password “mypassword”. In descending order of capability, the
levels of model access that you are most likely to use are as follows:
Supervisor – used if you do not take any action or enable the password system. The model is
fully editable and the user can change the password settings. All models start off in this mode.
FullAccess – the user can fully edit the model (add/delete/edit concepts and links) but not
change access control settings.
DelPrev – the user can add/edit/delete concepts and links made in the current or immediately
previous “session” i.e. concepts that are listed by the LN (list new) command. Concepts can be
created and corrected but in subsequent sessions they become unchangeable.
DelSession – the user can add/edit/delete concepts and links which were made in the current
“session” only i.e. concepts added since loading the model. Thus concepts can be created and
corrected but once the model has been saved and closed the user cannot change them.
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ReadOnly – concepts and links can be viewed,hidden, analysed and moved around the screen
but no editing (adding/ deleting or text editing) is allowed. In otherwords, you can change the
contents of the views (to explore the model) but you cannot change the “substance” of the
model. Note that select boxes in this mode always appear dashed.
None – no concepts or links can be seen. This is a being the starting level of access, before the
user logs in.
Other levels of access exist and these, together with other password system commands, are
detailed on our web pages at http://www.banxia.com/dexplore/faq/password.html.
The command nopassword disables the password system and can only be used when logged in as
supervisor. When password protection has been enabled and passwords set up, users must log into
the model in order to be able to add/edit concepts. The command login <password> gives the user
access to the model. The command logout returns the model to the standard level of access (which
will usually be “ReadOnly” or “None”).
We must stress that password protection is NOT a failsafe security device. Even when the level of
access is “None”, there are still other means by which the contents of a password protected model
can be extracted, if the user has the technical know-how. So, please do not use the password
system for highly confidential models.
And finally, do not forget that you and your colleagues should be using Decision Explorer® version
3.1.2 if you want to make full use of the password protection system. The Help menu, About item in
Decision Explorer® tells you which version of the software you are using.
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Decision Explorer® “Key Skills and Concepts”
At our “Come & See” Days and training events a lot of people ask a question, which boils down to,
“what are the top ten things that I need to learn to get going with Decision Explorer®?”. At many of
these events we are working with people who have never seen or used Decision Explorer® before and
many who have never come across any form of ideas mapping - be it cognitive, mind, causal or
concept mapping . In fact, for many people it is learning a mapping method, rather than learning to
use the software, that takes the time. When we are giving an overview of Decision Explorer® and
cognitive mapping we cover:
1.
2.
3.
4.
5.
6.
7.
8.

Visualisation of the model - changing the substance of the model and the content of a view.
The basics of data entry - entering, editing, linking and moving concepts.
Display scales.
Display styles - setting up and using display styles.
Views - “two sides of the paper”, map display and text display within each view.
The command line.
Laddering - building up a model, asking “how?” and “why?” type questions.
The difference between the “map” and “bring”commands.

As a new user the outline given below might help you to understand a little more clearly some of the
key concepts associated with Decision Explorer®. As an existing user, this outline might help you
when you are using the Decision Explorer® Viewer with colleagues and clients who are new to both
the software and ideas mapping.
1. Visualisation - perhaps the main pitfall for new users of Decision Explorer® is a misunderstanding
about what they are working with. In Decision Explorer® you are building up a “database of
relationships”, not a static graphical layout. Picture, if you can, a 3-D molecular model that you can
twist and turn and explore in different ways. With the views as your “doodle pads” you show and hide
parts of the model as you need to, in order to explore the ideas that you are working with. When you
add a concept to or edit a concept in the model, or when you add or edit a link, you are changing the
substance of the model (this wonderful, colourful 3-D structure that you might imagine). You do not
have to “copy and paste” between views, you just call up on to a view (show) or hide whatever you
choose. The content of the views are, therefore, as “fluid” as you like.
2. The basics of data entry - entering concepts - double click on mapping area, start typing, when
finished press f. Editing concepts - double click on the concept, make the edits, when finished press
f. It is that simple! Creating links - left click on (select) the concept to link from, keep the mouse
button pressed down, drag the pointer to the target concept to link to (a dotted select box should
appear) and release mouse button. Again, it is that simple. To move a concept - left click on a
concept to select it, keep the left mouse button pressed down, press down the right mouse button.
A “hand” should appear, then drag the hand to the desired location and release both mouse buttons
to “drop” the concept. If you find that there are any “artefacts” left on the screen (jagged arrows or the
remnants of a select box) then just press p (windows refresh) to redraw the screen.
3. Display scales - Decision Explorer® opens in “Normal” scale. The style fonts appear as they have
been set up i.e. 14 point fonts will appear as 14 point. You may want to switch to “Fit to Window”, at
some stage, because this ensures that newly added concepts are in view. In this mode the display
fonts decrease in size as more information is added to the screen. (Again, if you can’t see a concept
that has just been added and you are in “Fit to Window”, press p (windows refresh) to redraw the
screen).
4. Display styles are used to add emphasis through the use of display colour and font variations. Use
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the Property menu, Concept style properties option to make new styles (set the font, colour and
border attributes). To attribute styles to concepts, right click on the chosen concept, use pop-up
menu, style item.
5. To explain how “Views” work , think in terms of the "two sides of a piece of paper", on one side you
have a map display, on the other a text display. Decision Explorer® opens in map display. If you
issue a command, the result of which is a text listing, the view that you are working in will
automatically switch to text display. You can manually switch between map and text display using
the View menu items. The contents of the two “sides” of a view need not necessarily be related.
6. The command line is activated by pressing any alphabetical/ numerical key and appears along
the bottom of the screen. It is “cancelled” by pressing the ^key. Learning to use the command line
makes use of Decision Explorer® and the exploration of models a lot faster and more fluid. Adding,
editing and linking concepts can be done from the command line, as well as on screen.
7. Laddering is the process that is used to build up a cognitive/ causal map. For each idea in the
model ask - “why is this important to us?”, “what outcome are we trying to achieve?”. “Why?” type
questions ladder up the chains of argument. “How?” type questions - “how will this come about?”,
“how would this happen?” ladder down the chains of argument. You are building up a hierarchy of
ideas, surfacing and defining desirable outcomes (and, as a consequence, undesirable ones too)
and exploring and making explicit the “stepping stones” (supporting arguments) which lead to the
outcomes.
8. The “MAP” and “BRING” commands - remember that with Decision Explorer® you are building up
a database of relationships, not a static graphical layout (think of the “3-D molecular model” that you
are building within the heart of Decision Explorer®, from which you “pull out” information onto the
views, as desired). If you want to focus in on part of your model, just move to another view (by
clicking on one of the view tabs along the bottom of the screen) and map the concept(s) of interest
and carry on working. The “MAP” command e.g. map 10 (which means map concept 10) maps the
chosen concept plus any linked concepts. This command will replace anything already shown on
the view. The BRING command is used to add more information to that already displayed. For
example, “Bring 10”, will add (bring) concept 10 onto the current map view.
These are the main points that we cover when first introducing people to Decision Explorer®. You
may find this summary useful when introducing new users to the software and associated
techniques.
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Toolbar Customisation
Decision Explorer® has always had the ability to customise the toolbar, but not many people use the
facility. Here are two good reasons for doing so! The new full screen mode enables you to maximise
the map display area, but turning it off requires you to remember either the ‘full’ command or the AltW+F keystroke. If you use the Control->Toolbar-> Selection item you can add a new toolbar. Then
use Control->Toolbar-> Customise to add the Full button (at the bottom of the View items list). Now
you can just click to switch modes! The continuous listing button at the bottom of the List items
allows you to turn off the auto-clear when a command starts, allowing you to build up a longer text
view for export.
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Copying and pasting explained
There has been a specific request for this item, and its message is worth repeating (since if one
person is having difficultly, there may be others). The question is: “how exactly does copy and paste
work?” - sometimes it doesn’t behave as people expect. The Windows ® clipboard is a way of
transferring data from one application to another and within the same application. What you may not
realise is that when you copy something to the clipboard an application often makes more than one
type of data available. The data formats that Decision Explorer® uses depend on what you are doing.
If you are editing a concept or the command line, then the copy/paste is done using plain text, and
is exactly as you would expect. If you have a map visible in the current view, then copying to
clipboard will make available two types of data: a picture of the current display (either as a “metafile”
or as a screen-grab bitmap) and a private data format containing details of the concepts on the
display. This private data is limited to the currently selected concepts, or if there are no
concepts selected, then all those on the map view. If you have a text display visible on the current
view the clipboard contains a plain text version of the text display, and private data containing details
of the currently selected concepts, or if there are no concepts selected, then all those on the text
view
For both of these, the private data contains all selected concepts, if any are selected. So if you want
to transfer concepts to another model, the view contents do not actually matter, just the current
selection. To select all concepts in the model either use the command SC=L or hold the Ctrl key
down when selecting the Edit menu Select all item (otherwise it just selects those on the map view).
Also note that you don’t use the clipboard to transfer concepts from one view to another - that
duplicates the concepts in the model. Use the View menu Bring layout from item if you want a
layout transferred from one view to another or map the concepts that you want.
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XML - what it is and how you use it
For many years, Decision Explorer® has been a powerful tool for modelling qualitative information.
Users have built many models and they have proved very useful as-is. Once the model is complete,
people often want to move parts of it to other applications for display purposes, or to do further
analysis. People also often have existing data that they want to be able to create a model from.
Banxia has provided a variety of methods to do this, such as copying to clipboard and direct import/
export to other applications. Some developers have also used the internal data transfer format to
import models, perhaps allowing download from web sites or other applications. Each time the
solution is proprietary, and the developers have to work to custom formats.
XML(eXtensible Markup Language) is a data transfer format. It is not a miracle cure, but it is a
standardised way of structuring data. This means that if you can get suitable data out of one
application in XML format, you can usually use a translator tool (such as XSLT) to transform it into a
form suitable for the destination application. This means that transfer of information becomes a lot
easier when all applications support XML. Of course, there is no point in taking an XML file with the
company accounts and trying to transform them into a cognitive map - the data has to be
appropriate - but if you have data that is essentially a map with ideas and links between them then
you should be able to use XML as the medium for transfer into Decision Explorer®.
Current support
To use XML you must have Decision Explorer® 3.2 or later. At the present time, this is only available
as a Beta test version, though it should be quite usable for general use. You can download a
program that will patch an existing FULL licensed version of Decision Explorer® (not usable with
Student or Viewer versions at this time).
XML supported in Decision Explorer® 3.2
· Export of complete model to XML
· Export of selected concepts to XML
· Import of the Link styles (hold shift in link style editor to get load/save buttons).
· The complete model includes all views, styles, link styles, concepts, links.
How to use it
The XML output is available using the standard Decision Explorer® Export Wizard. Simply select the
File menu Export item, and then select the XML option on the first page. Click Next, and you will get
the XML wizard page.Leaving all the check boxes ticked, selecting All views, and All concepts will
give you a complete XML representation of the model. If there are parts that you do not wish to have,
then you can of course turn the appropriate options off, but XML is designed to be flexible, and your
target application should be able to ignore unwanted data.
The data in the XML file is very specific to Decision Explorer®, and you will probably need to use a
transform application (perhaps using XSLT) as an intermediate stage before importing.

© 2010 Banxia Software Ltd

14

Decision Explorer Newsletter Compendium

Future support
As use of the XML data increases, we will be adding new capabilities. If you have particular
requirements, please let us know. We intend to add the ability to import the XML data, and also to
import and store arbitrary (unknown) attributes against concepts and links. For example an identifier
may be output by an application so that it knows which concept relates to its own internal data
structures. When re-exported, the identifier will allow a proper merge to occur. Note that the file
format in Decision Explorer® may be changed when this information is stored, losing compatibility
with prior versions of Decision Explorer®.
Technical Information
More information about XML in Decision Explorer®, including a download of the test version with XML
support and details of the schema used by Decision Explorer® 3.2 are available on our web pages
at http://www.banxia.com/dexplore/xml/. These pages will be updated as the software develops.
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Speaking from experience …
This article was written by Professor Fran Ackermann, University of Strathclyde. Fran has been
involved with the development of the cognitive mapping technique since “the early days” at University
of Bath. She is one of the original research team who helped to develop the COPE software, which
went on to become Decision Explorer®. She has used cognitive mapping, both paper based and
electronically supported, throughout her working life, she is therefore uniquely placed to offer help
and advice on the use of Decision Explorer®, in a workshop setting. Whilst this paper is written in
the first person and reflects my own experiences, many of the ‘tips’ noted have come from working
with Colin Eden either through conversations on workshops or observation. I am therefore grateful to
his contribution.
While there are a number of different ways of being able to capture contributions and structure them,
for example using the Oval Mapping Technique (OMT) or Group Explorer (Eden and Ackermann,
1998) I find myself more often than not working with Decision Explorer® in a form of Visual Interactive
Workshop (Ackermann and Eden 1999). This is partly as the software allows me to be able to
quickly and easily edit, add and delete contributions and relationships, but also because I am able
to search [find] and analyse the material (either during coffee breaks or sometimes, when
appropriate, in front of the group). The groups involved can therefore concentrate on the business at
hand and not get distracted by technology or have to worry about making sure that they are writing
down their contributions. However, over the years of working in this mode I have found a number of
operating procedures that are noted below.
One of the first that comes to mind is in relation to the amount of information presented on a
Decision Explorer® screen. Although I am comfortable working with very complex maps comprising
40 or more contributions, this can be daunting for participants who are not familiar with working with
maps and therefore unsure as to where on the map to start reading or how to navigate around the
morass of information. I have found through experience (and there is some good theory to back this
up) that starting with around 15-20 contributions on the screen and then slowly building the picture
can help manage this sense of being overwhelmed. One way is to use the Bring command and
gradually drill down the chains of argument developing one chain at a time and allowing what
essentially is mental digestion time. Another method that appears to work (although I have only
infrequently used this) is that of using sequential views, each showing another level of detail (this
mode however is limited to the number of views available which in the full version of Decision
Explorer® is 40).
Related to this, is the issue of screen space in general. Even with the high-powered projectors
available today (and I recommend that if you can you use a projector that supports XVGA i.e.
1024x768 pixels, and has a brightness of 1200 lumens) the number of contributions that can be read
on a screen is still limited (even with the building up routines). While it is possible to switch between
the fit to view mode to show the overall structure and the normal view to show the text, this can
become quite disruptive to a group’s thinking process. One means of being able to increase the
amount that can be viewed is to turn off the various menus and toolbars and work with an essentially
blank screen. I use Decision Explorer® with only the view tabs showing and no menus at all. This
obviously means being sufficiently familiar with the commands so as to be able to access them
without the aide memoir of the menus.
A second benefit from this mode of working is that by not having the menus I tend to use the various
short cuts (i.e. hot keys e.g. Alt Y for the style selector) that are available. This not only speeds up
operations but also more importantly reduces or avoids the disruption caused to the group when a
large dialogue box or menu appears on the screen effectively hiding the material beneath it. The only
exception to this rule is when I am changing the direction of a link, or adding a new link, as it is

© 2010 Banxia Software Ltd

16

Decision Explorer Newsletter Compendium
useful for the group to see this operation being performed in front of them.
Alongside and related to the consideration of the number of contributions on the screen is the
frequency of which you ‘tidy up’ the material. This issue is one I find quite difficult to manage as I am
continually wanting to ensure that the view has no links crossing one another and that all of the links
are ‘correct’ in a hierarchical sense. Consequently I am frequently tempted to move the contributions
around the screen. This continuous moving of contributions however can be disconcerting to the
group as they mentally have ‘located’ the contributions and shifting them around can add to the
mental complexity of the task. To try to combat this, I forced myself to use the track pad (rather
than an external mouse) however unfortunately it didn’t take long before I had developed sufficient
dexterity to move contributions around easily and quickly and I was back where I started. I now just
try to mentally remind myself not to continually move contributions.
Another means of making it easier for participants to manage the complexity of the material is to
start with an overview of the material. One analogy for this is the familiar road map as most road
maps provide a good overview of the country with all the major cities marked along with the routes
between them. If the reader then explores the routes between two cities in more detail, he/she will
probably find that it traverses a number of smaller towns not on the overview.
Added to this, is if you have used a colour code to help with navigating around the model (adding to
the benefits of having an overview) having a description written on a flip chart in front of the group is
helpful. This is also the case with the meeting’s agenda. Often, when working with computer based
models participants can become concerned about their involvement, and this gives rise to role
ambiguities/anxiety. Reviewing the agenda can help reduce this.
Before running a workshop there are a couple of things that are worth considering. The first (which
depends on whether a previous form of data collection has been carried out e.g. interviews or OMT)
is to ensure that the numbering of concepts does not reveal the proponent. This ensures that
members are able to change their mind without penalty. More than one person can also ‘own’ a
contribution – which adds to the negotiation process. The mix command is helpful here. At the end it
is useful to have access to a printer
Finally in relation to the process of facilitating the group’s progress. I find that working in around 20
minutes cycles tends to work best. Here you are able to allow the group to contribute and diverge for
a period of time and then through reviewing the material converge on an agreed structure. This helps
by providing participants with a sense of progress (as each cycle is a milestone) and carried out in
conjunction with an agenda written up on a flipchart, items can be ‘marked as done’ and progress
easily revealed. This helps to keep the group energised.
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Exploring some of the less known features in Decision
Explorer
From time to time we are asked questions such as "how do I merge models?" And "what is the
easiest way to share models between users in a project team?" We thought that we would take this
opportunity to talk you through the answers to these questions and, in the process to introduce you
to some of the less well known facilities in Decision Explorer®.
Merging models.
A common method when working with a group is to start by interviewing each group member
separately, and mapping their ideas about the problem or issue which is the focus of the study. In
these individual interviews it is likely that the maps will have been recorded using pencil and paper,
rather than entered directly into Decision Explorer® (although the interviewer can, of course, use
whichever method he/she considers to be the most appropriate for eliciting and recording the maps).
If the maps have been taken down on paper (and not entered directly into Decision Explorer®), then it
is a straightforward task to enter the information into Decision Explorer®, ready for analysis and
merging. Having started with a paper based process, the computer models may be used for
feedback to the individual interviewees, or as the basis for second interviews, before moving on to the
group process. The composite map, which is the result of the merging process, will then be used in
the group meetings to facilitate negotiation about the issue.
The map merging process can be carried out as follows: create a new, empty model (you might want
to name it "group"). Open the model for the first interview that will contribute to your group model.
Select all of the concepts in the model (assuming that you are using the whole map). The command
"SC = L" is one way to do this, it asks Decision Explorer® to make the set of selected concepts
(SC) equal to the list (L) of all of the concepts in the model. Alternatively hold CTRL down while
selecting the edit menu Select All item. You then use the standard Windows copy and paste
options to transfer the contents of the individual interview model into the group model. Select the
Copy option from the Edit menu, switch to your group model and paste in the concepts from the
clipboard. You can then repeat this for each interview model.
An issue that you will have to consider is that of concept numbering. The standard option when
Decision Explorer® transfers concepts between models is to “ensure separation” i.e. no overlap in
concept reference numbers. After transferring the first set of concepts to your group model you want
Decision Explorer® to renumber the concepts from subsequent models, you can do this either by
selecting the 'Ensure separation' paste option. Or, an alternative is to renumber the concepts before
you copy them across. You might number all of interview 1 as 1 to 99, interview 2 as 100-199,
interview 3 as 200-299 and so on. This makes it easy to identify the original interview source.
Renumbering to fit a range is done using the Edit menu Renumber item. (You also have the option to
"shuffle" concepts afterwards using the Mix command so that the source is not identifiable).
Now you have a model with the data from all of the interviews, but the groups of concepts are all
separate "islands". The process of merging now begins in earnest. There is no “magic way” to do
this, but a good way to start is to use the FIND command to look for key words that you think have
occurred in more than one model, for example "market~" or "Europ~". You then look at ideas that
appear to be similar - for example "achieve greater market share" and "expand our market". Use the
MAP or X commands to view each concept in context, to check that they are actually talking about
the same thing. If they are, use the concept merge command to combine them. If they have the
same phrase but a different meaning, a careful edit to add a keyword can be used to clarify the
difference. After a period of merging, review the model, use the cluster command to look at the
emerging structure of the combined model. Map the clusters, look at their content and you may find
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more concepts that can be merged. Merging models can be a slow process, but it is an excellent
way of getting to know your data in detail and gives a clear picture of the “shades of grey” that exist
in the interviewees’ understanding of the situation.
Sharing models
An important aspect of sharing models is keeping track of who has made which changes to the
model. It is possible to track who has entered new concepts and who last edited concepts. This is
where Decision Explorer®'s user name facility can be helpful. The Control menu, Model options item
displays a dialog containing an option marked "Prompt for users name on open". If this box is
checked, the User Name Selector dialog will appear automatically each time the model is opened.
The name of the last person who edited the model appears highlighted in this dialog for convenience.
The current name selection can also be changed at any time, or the list of names initially set up,
using the Property menu, User name item (or the shortcut Alt+N). Providing that users are rigorous
in making sure that it is their name (and not someone else's that is being used) it is now easy to
track who has changed what. The commands "Leditor" and "Lcreator" give a listing of who the last
person to edit a concept was, and who created it in the first place. These commands can be used
on ranges of concept numbers e.g. Leditor 1-10, lists the names of the last people to edit concept
numbers 1 to 10, and Leditor 1#10, lists the names of the last people to edit concept numbers 1 and
10. If no range of concepts is specified the results returned will be for all of the concepts in the
model.
You may have noticed that when you create and save a Decision Explorer® model, a *.mlk file is
created, as well as the model file (a *.mdl file) and the model backup file (a *.mdk file). The *.mlk file
is a "lock" file, which is created automatically and used when models are "shared". If you want to
share models between a project team, then generally the easiest way to do this is by putting the
models on a central server, in a shared directory which the team can access. If this is done there
would be the potential for having two users trying to edit the same model at the same time - the lock
file is a device to prevent this. In single user use the lock file can be ignored but when sharing
models it serves a useful purpose. When the second user tries to open the file, they will be told that
the model is in use, and shown the currently selected name so you can contact them. Important
note: please test model locking on your system before relying on it. Windows NT server for example
requires that "opportunistic file locking" be turned off, a tool for which is available on our web site. If
you have any questions about anything featured in this article, please email support@banxia.com.
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“Emergent Strategising” within a Community Healthcare
IT Project Team
By Paul Comac, Management Consultant, Provider Support Unit, Northern Ireland Health and
Personal Social Services
Summary
The Provider Support Unit used Decision Explorer® to facilitate an IT Project team from a Northern
Ireland Healthcare Trust in determining the key issues to be addressed in the implementation of a
large Patient Centred Information System (PCIS). The feedback from the group indicated that real
benefits were achieved in helping group decision-making in a complex area. Decision Explorer®
helped to promote the kind of dialogue, creative options, focus and avoidance of destructive behavior
that characterise effective problem solving in a team.
Background
Down and Lisburn HSS Trust is a large integrated organisation providing services in the acute,
community and mental health sectors. The Trust needed to invest in an integrated PCIS for the
community and mental health sectors. A multi-professional team was drawn together and one of
their first priorities was to identify and agree the key issues to be addressed to enable successful
implementation.
Process
Oval mapping was used to capture and “map” the relationships between the eighty or so ideas
identified by the group. The ten identified categories; benefits, training, evaluation, technical,
communication, confidentiality, functionality, ownership, outside influences and resources, were
each assigned a view in Decision Explorer®, thus enabling the group to follow through with real time
decision-making. During the workshop (facilitated by myself, Paul Comac) using Decision Explorer®,
it became apparent that the group was involved in “emergent strategising”, clarifying the future
direction for themselves by developing a set of effective strategies.
Outcomes
The outcome of the workshop was an agreed, coherent interpretation of the map captured in the
following paragraphs, the actual concepts are in shown in bold type and are numbered:
“In order to produce a more efficient and effective service (47), the project needs to ensure that
the system supports the business (65) and ensure that the information is reliable (1). Ensuring
that the system supports the business (65) can be influenced by resourcing the project adequately
(80), consulting with all staff (89) and complying with statutory obligations (13). Ensure that
the system supports the business (65) can help reduce staff resistance(69) and influence the
creation of an integrated person centred database (36).
Ensuring that the information is reliable(1) can be influenced by Training staff(26), resourcing
project adequately(80), introducing new data collection methods(17) and establishing
ownership and direction with professionals(84) Ensuring that the information is reliable(1)
can influence the development of more holistic and less mechanistic care(48).
Creating more holistic and less mechanistic care (48) can be influenced by creating an
integrated person centred database(36) which can in turn be influenced by resourcing the
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project adequately(80).
A further Decision Explorer® analysis of the map revealed that gaining professional ownership of the
new system and enabling more holistic care of clients were key strategies pivotal to successful
implementation. Gaining the support of the professionals was dependent upon convincing them of
the potential benefits to improving the quality of care to the client. Thus a view benefits was of
paramount importance.
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Items of interest
This section has minor items that are of interest.

13.1

From the bookshelf
Named the "Best Book of 1995" by the Public and Nonprofit Division of the North American
Academy of Management, we would like to commend to you John Bryson’s book “Strategic
Planning for Public and Nonprofit Organizations” (Revised Edition, published by Jossey-Bass, San
Francisco, CA.1995). Until now this book was missing from our bibliography on cognitive mapping,
decision support, strategy formulation, and applications of Decision Explorer (which can be found at
http://www.banxia.com/dexplore/debiblio.html).
The original edition of this book was reprinted 9 times and became “the standard book” in the field.
As well as giving an introduction to the dynamics of strategic planning the book deals with what are
seen as the key steps in using the strategy change cycle to think and act strategically, and getting
started with and managing the process of strategic planning. The resources section also contains a
section devoted to oval mapping, which is a paper based form of the cognitive mapping technique
supported by Decision Explorer.
In praise of this book, Beverly Stein, chair of the Multnomah County Board of Commissioners,
Portland, Oregon, comments that: “When I am asked for advice on strategic planning for government
or nonprofits, the very first resource I recommend is John Bryson’s book. It is a must-have tool for
anyone working toward the common good.”
If you are interested in more information about this book, please visit http://www.josseybass.com/
and use the search facility at the top right of the page.

13.2

Impact Explorer
We are pleased to announce that Impact Explorer has now been released. This new piece of
software is aimed at risk assessment/ voting applications, for by groups in a facilitated workshop
setting. Impact Explorer allows you to vote on ideas in various ways and to display comparison
matrices. The comparison matrices have a number of per-set options, such as probability vs. impact,
cost vs benefit, risk vs reward, but they can also be customised. You can , if you wish, use Decision
Explorer's DDE (dynamic data exchange) capabilities to exchange information with Impact Explorer,
but you do not have to have both tools, each is a stand alone application. Details can be found on
our web pages at http://www.banxia.com/impact/index.html.

13.3

Using DDE with Decision Explorer
Did you know that Decision Explorer has DDE (dynamic data exchange) capabilities and is
programmable? The DDE capabilities allow you to exchange information with other Windows
applications and to develop your own add-ons to Decision Exploere. Using DDE you can access
nearly all of the information in Decision Explorer and you can create and edit concepts and links
from external applications. You can also create a "hot link" to monitor all user activity. If you would
like to know more about DDE in Decision Explorer, then please email to info@banxia.com and ask
for the DDE Help File.
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Oval Mapping
In the last issue of the Decision Explorer Newsletter we announced the launch of "Post-It®" style
ovals and the website www.ovalmap.com. Since then there has been a lot of interest in ovals and
very positive feedback about their use! Oval mapping can be used at the start of a workshop to
encourage social interaction and to "get the creative juices flowing" before moving on to computer
supported group working using Decision Explorer.
"I adhered to the Eden/Ackermann prescription described in their "Making Strategy" book, and it
worked. My OMT session went so well that I have placed another order for more ovals. I will definitely
use the ovals and OMT again in the future." Bill Cummins, Cummins Mark eting Consulting, Santa
Clarita, California, USA.
"The Banxia oval mapping cards have proved a tremendous success. They are easy and flexible to
use, can be safely applied to many different surfaces (flipchart paper, whiteboard, glass, walls), and
link naturally to the yellow post-it 'standard concept' format in Decision Explorer. It is perhaps an
indication of their attractiveness and generic application that several of our clients take ovals, 'left
over' from workshop use, back to their offices!" Ashok Hegde, Europel Group, London, UK.
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